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PARK PROJECT CHECKLIST FOR FINAL PRODUCTS

The following data files must be included in a final vegetation map data set.

0 Technical Report

o0 Plots Database

o Plots and AA Field Photos

o Digital Aerial Photo Data, Flight Index, Graphic & Metadata

0 Vegetation Plots (point data) Spatial Data, Graphic & Metadata

0 Vegetation Map (polygon data) Spatial Data & Metadata

o Park Boundary Spatial Data & Metadata

0 Thematic Accuracy Assessment Points Spatial Data, Graphic & Metadata
0 Accuracy Assessment Contingency Table

o Final Vegetation Map Graphic using NPS Map Standards




INTRODUCTION

The attached guidelines are designed to standardize and thus facilitate the rapid turn-around of Vegetation
Inventory Program (VIP) final products and get them online as quickly and efficiently as possible.

They reflect the USGS-NPS decade-long experience on best practices of how to group and parse the VIP digital
products for the current online environment maintained at the USGS Center for Biological Informatics in
Denver, CO.

While it is recognized that there will always be exceptions that will have to be dealt with on a case by case
basis, the USGS-NPS management team has discovered that adherence to this model of data organization and
formatting of final products accelerates the turn-around for project data web posting and as such, makes the data
available to NPS staff, natural resource scientists, federal agencies and the public in a timely manner.

We understand the degree of effort that is required to generate a high-quality, standardized vegetation map
under the USGS-NPS Vegetation Inventory Program. We recommend you allow sufficient time and effort to
produce final products adhering to the specified formats in this document for consistency and rapid availability
of the data.

To develop final reports for vegetation mapping projects, investigators should consult with project key officials
and follow the appropriate NPS guidelines. The final report will address vegetation classification and
description, vegetation mapping, and accuracy assessment. It will include a full description of project methods,
results and a summary discussion. If the report will be published within the NPS NRTR series or another
technical report series, additional standards and guidelines may be applicable.

After the report, maps, databases, and other digital products have been reviewed and accepted as final by the
project key official, they will be reviewed by the USGS/NPS National Vegetation Inventory Program (NVIP)
and placed on the website. In order to facilitate this effort, please follow the file format and naming convention
guidelines provided below. Many projects were initiated prior to the issuance of these guidelines by NVIP. In
those cases, investigators should consult with park, network, and/or NVIP staff to determine how best to meet
the new guidelines.

Any questions, or request for clarification should be addressed to Ms Theresa Singh, VIP data content manager
(tsingh@usgs.gov) at USGS CBI.



mailto:tsingh@usgs.gov

PARK PROJECT OUTLINE FOR FINAL PRODUCTS

I. Aerial Photography
a. Orthophoto Mosaic Graphic
b. Spatial Orthophoto Data (.exe)
c. Flight Line Index
II. Vegetation Information - {one link}
a. Vegetation Report, containing the following items:
- Photo Interpretation Key
- Vegetation Descriptions
- Vegetation Key
- Photos of Map Classes
- Accuracy Assessment Methods and Results
III. Field Data
a. Field Plots Points Graphic
b. Spatial Field Plots Data (.exe)
c. Plots Database (MDB)
d. MS Excel format of Physical Descriptive Data for Plots
e. MS Excel format of Species List Data for Plots
f. Field Photos collected during PLOTS and AA (.zip or .exe)
IV. Geospatial Vegetation Information
a. Vegetation Graphic
b. Spatial Veg Data (.exe)
c. Spatial Boundary Data (.exe)
V. Accuracy Assessment Information
a. AA Points Graphic
b. Spatial AA Data (.exe)
c. MS Excel Contingency Table
VI. Project Metadata
a. Aerial Orthophoto
b. Field Plots
c. Spatial Veg Data
d. Boundary
e. Accuracy Assessment
f. Others - as appropriate
VIIL. Other Helpful Information for File Creation
VIII. File Naming Standards




Aerial Photography

a.

Graphic File: The pdf file name is the parkname and the type of geospatial data being shown,
such as Orthophoto. Example: grteortho.pdf. Example:
http://biology.usgs.gov/npsveg/grte/images/grteortho.pdf

Spatial Data (.exe): This is a digital file of the land cover (aerial) imagery data used in this
project. All geospatial data must be in UTM NAD 83. In most cases this is a CIR mosaic or an
orthophoto. Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/grte/grteortho.exe.

Aerial Photo Flightline Index — photos.pdf. A PDF file of a flightline index linking the flightline
numbers to the aerial photos and listing the aerial photos by numbers. Not all of the aerial photos
are shown, just every other one on each flightline. Example:
http://biology.usgs.gov/npsveg/zion/photos.pdf.

Graphic File: This is a PDF file for each aerial photograph, using a unique photo number on each
photo. Example: 2-3.pdf, 6-11.pdf, 18-20.pdf, and 23-36.pdf. Examples:
http://biology.usgs.gov/npsveg/zion/aerials/2-3.pdf,
http://biology.usgs.gov/npsveg/zion/aerials/6-11.pdf,
http://biology.usgs.gov/npsveg/acad/aerials/18-20.pdf and
http://biology.usgs.gov/npsveg/acad/aerials/23-36.pdf.

Vegetation Information

a. Vegetation Report — ONE REPORT: Create a PDF full report (parknamerpt.pdf).
* Example: http://biology.usgs.gov/npsveg/zion/zionrpt.pdf.
= Report MUST contain: Vegetation Description, Vegetation Key, Map Class
Descriptions, Photos of Map Classes, Photo-interpretation Key, Accuracy Assessment
Methods and Results.

Field Data

a. Graphic File: The pdf file name is the parkname and the type of geospatial data being shown,
such as Plot locations. Example: zionplots.pdf. Example:
http://biology.usgs.gov/npsveg/zion/images/zionplots.pdf.

b. Spatial PLOTS Data: The executable files should contain the geospatial shapefile of the PLOTS
data. All data must be in UTM NADS83. Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zionplot.exe.

c. Microsoft Access PLOTS Database: Field Data for Plots, Accuracy Assessment, Physical
Descriptive and Species Listing Data - parknamedata.mdb. This is a Microsoft Access Database
of the park field data, such as accuracy assessment, accuracy assessment species, observation
points, plots, plot-species, geology classes, locations, jurisdictions and any other park field data.
Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/ziondata.mdb.

d. Physical Descriptive Data for Plots - The plots file is extracted from the parknamedata.mdb
database. The file name is plots.xls. Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/plots.xls.

e. Species Listing Data for Plots - The sp_cov file is extracted from the parknamedata.mdb
database. The file name is sp_cov.xls. Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/sp_cov.xIs.

f. Field Photographs collected during PLOTS and AA: Contained within the PLOTS database are

references to field photos collected as part of the project. We would like a .zip or .exe file called
“field_photos”. The files within the .zip or .exe usually contain jpeg, gif, or pdf format. Please do
not exceed 2GB on each file. If so than create more than one .zip or .exe file and call it

field photosl.zip or .exe, field photos2.zip or.exe and etc.

Geospatial Vegetation Information

a.

Final Map Graphics: Map layouts need to follow NPS standards. For NPS standard map
templates, see: http://imgis.nps.gov/templates.html. These are graphic files (.pdf). The pdf file
name is the parkname. We would like a low resolution for viewing and a high resolution PDF
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VI.

VII.

C.

for reprinting maps. Examples: http://biology.usgs.gov/npsveg/zion/images/zionveg.pdf,
http://biology.usgs.gov/npsveg/zion/images/zionmap_large.pdf.
Spatial Vegetation Data: The executable files should contain the following: The shapefile or
geodatabase of the vegetation polygon and associated attribute data. All data must be in UTM
NADS3.
Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zion.exe.
Spatial Boundary Data (.exe) - Shapefile of the park boundary used for this project: Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zionbdy.exe.

Accuracy Assessment (AA) Information

a.

b.

Graphic files (.pdf). The pdf file name is the parknameaa. Example: zionaa.pdf,
http://biology.usgs.gov/npsveg/zion/images/zionaa.pdf.

Spatial AA Data: The executable file which contains the shapefile or geodatabase of the
Accuracy Assessment geospatial data. All data must be in NAD83. Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zionaa.exe.

Accuracy Assessment Contingency Table — This accuracy assessment matrix (aa_matrix.xIs)
should include the code description below the matrix. Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/aa_matrix.xls.

Project Metadata

a.

d.

c.

f.

Aerial PhotoMosaic Metadata — metaparknameortho.txt. Metadata for aerial orthophoto mosaic
(Text format only). Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/grte/metagrteortho.txt.

Field Plots Metadata — metaparknamefield.txt — Metadata for the Plots Microsoft Access
Database (Text format only). Example: http://biology.usgs.gov/npsveg/zion/metazionfield.html.
Geospatial Metadata - metaparknamespatial.txt — Metadata for Geospatial Vegetation
Information (Text format only). Example:
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionspatial.txt.

Park Boundary Metadata - metaparknamebdy.txt — Metadata for Park Boundary (Text format
only). Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionbdy.txt.

AA Metadata - metaparknameaa.txt — Metadata for Accuracy Assessment Information (Text
format only). Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionaa.txt.
Other metadata, as appropriate

Other Helpful Information for File Creation

a.

Instructions for PDF Conversion of Vegetation Mapping Reports:
(Instructions refer to MS Word 2002 / Acrobat 7.0 / Reader 9.0)

Hint: PDF conversion is much easier if the Word document you are trying to convert is as small
as possible. Most graphics are unnecessarily large. To reduce them, left click on them, cut, then
choose ““Picture (JPEG)” from the ““Paste Special’” dropdown under the Edit menu. The
graphic/photo should go from having little dark handles to having green or white circles for
handles. Sometimes all you get is a black square, in which case you have to trick Word by
choosing something else from the Paste Special menu until you get a format that will, when
pasted as a JPEG, look like your original graphic/photo. Depending on the number of
photographs and graphics in your document, you can reduce the size by an order of magnitude.

1. You can do the conversions while waiting for the NRTR and TIC numbers, because
requested edits are usually minor.

2. In creating the parknamerpt.pdf file, you will generally have to break it into chunks no bigger
than 40-50MB in order for the machine not to hang up while converting/tagging. I often do
the entire report through Appendix F as one chunk, then appendix G-H (field key) as another
chunk, then Appendix J (map class guide) by itself.
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3. Creating the tagged document takes quite a while (at least 10 minutes per chunk) and it is not
a good idea to be doing anything else on the computer while the conversion is going on.

a.

When all the chunks have been converted successfully, run through each chunk and
make sure there are no gross errors like extra or missing pages, or errors in formatting
or page breaks, or strange colors invading the figures.
Once all these have been fixed, either in Word and reconverting, or in Acrobat, rejoin
the chunks using the “Insert Pages” command under the Document menu.
Once you have a single document, check through the entire thing and make sure there
are no missing or extra or blank pages, the formatting looks good, etc.
Rebuild the TOC at the front of the document to repair the reference errors created
when you broke it into chunks.
Go through the document page by page with the TouchUp Toolbar open (Tools ->
Advanced Editing -> Show TouchUp Toolbar)
Activate the TouchUp Reading Order button and on the menu that opens, make sure
all of the options are checked. Each page will then appear as a series of numbered,
Xed or grayed-out boxes.
On each page, make sure of the following:
1. All text, including titles, figure captions and table headings, is in gray text
boxes
ii. Figures are in figure boxes
iii. Tables are in Table boxes
iv. The numbers in the boxes make sense as to their reading order
If not, and especially if the formatting is a mess with extraneous structures and
numbered boxes, use the “Clear Page Structure” button on the Reading Order
TouchUp menu to start over.
Activate the TouchUp Reading Order tool, highlight the text or table or figure (all of
it, trying not to overlap adjacent structures much or at all) and select “Text” or
“Table” or “Figure” buttons as appropriate from the Reading Order TouchUp menu.
Don’t bother with any of the other choices. They just complicate things.
You can fix the order of things by clicking on the “Show Order Panel” button on the
Reading Order TouchUp menu, scrolling to the right page number, and using your
mouse to drag the various elements around (grab the little colored boxes on the left;
the text doesn’t drag!)
Tables and Text boxes do not need tags. Figures (photos and graphics) do. To create
tags for these:
i. Select the TouchUp Object Tool from the TouchUp Toolbar.
ii. Right click in the figure you want to tag.
iii. Select “Properties” from the bottom of the menu
iv. Select the “Tag” Tab from the properties menu and enter your tag text in the
“Alternate Text” box.
v. Select “English US” from the Language dropdown menu below the Alternate
Text box.
vi. Use these standards for tagging figures:
1. For scenic photos, enter a 1 to 4-word description of what the photo
illustrates: “Yampa River Canyon”
2. For graphics, enter “Figure XX map” or “Figure XX graphic” or
“Figure XX chart” — as appropriate
3. For photographs with captions, enter “Figure XX photo”
4. For photographs without captions, as in the appendices, enter a
descriptor, like “Acer negundo Woodland photo” or “Riparian
Shrubland Complex aerial photo example”




5. [If'there are several photos for a figure, enter the text as recommended
above, then a number that reflects the reading order number: “Bromus
tectorum Herbaceous Vegetation photo 1”

4. When all of this is done and you have checked back through the document to make sure
nothing was forgotten, *then* fix the bookmarks and links as stipulated in the guidelines and
finally, run the accessibility check.

5. Finally, for both PDF reports, while the document is open, click on the “Reduce File Size”
option under the File menu. You’ll be amazed at how much your document shrinks.

b. GENERATING .EXE FILES
* Depending on the WinZip version:

o For the Full Advance Version: Create the zip file than under file name Actions,
scroll down to Make .EXE File and click on it to create an .EXE file.

o For a Limited Version: Create the zip file, close the zip file and go to file of where
it located and right click on the file and scroll down to WinZip and than scroll
down to Create Self-Extractor (.EXE) and click on it to create an .EXE file.

o Ifunable to do either one of these process as described above than create a ZIP
file only.

c. DELIVERING A GEODATABASE -VERSUS -SHAPEFILES

= The Vegetation Inventory Program would prefer that all spatial data (e.g. PLOTS point
data, AA point data, Vegetation polygons, photographs) are delivered in one
GEODATABASE with the appropriate relationships retained.

* For a good example of a geodatabase, please download and review the Northern
Colorado Plateau Network’s geodatabase structure in Natural Bridges NM.
Example: http://biology.usgs.gov/npsveg/nabr/index.html

= Personal Geodatabases or File Geodatabases are recommended.

= Only one Geodatabases is needed, containing all the spatial data.

VIII: FILE NAMING STANDARDS:

e NO capital letters used in naming each file.
e The following is a list of standard naming conventions:
= Acrial Photography
0 parknameortho.pdf
0 parknameortho.exe
O photos.pdf
0 1-02.pdf or 11-13.pdf or 4-5.pdf depending on the unique photo number.
= Vegetation Information
o parknamerpt.pdf
0 class matrix.xls (OPTIONAL)
= Field Data
0 parknameplots.pdf
parknameplot.exe
parknamedata.mdb
plots.xls
sp_cov.xls
0 field photos.exe or .zip — containing photos referenced in the PLOTS DB.
= Geospatial Vegetation Information
o parknameveg.pdf
0 parknameveg large.pdf
0 parkname.exe
0 parknamebdy.exe
= Accuracy Assessment Information
0 parknameaa.pdf

O 00O
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o
o

parknameaa.cxe
aa matrix.xls

= Project Metadata

o

O oO0O0oo

metaparknameortho.txt
metaparknamefield.txt
metaparknamespatial.txt
metaparknamebdy.txt
metaparknameaa.txt
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Aerial Photo number is a unique number on each photo that should be used
to create an pdf web page.
Example; 2-3.pdf. 5-9.pdf, 12-13.pdf, 27-11.pdf

There are 5 types of pdf files. The pdf file name is the park name and the type
of imagery that is being shown. Example: zionaa_ pdf, zionveg.pdf,
zionveqg_large. pdf, zionplots.pdf, grteortho. pdf

The PDF webpage will always contain the following files: photos.pdf,
parknamenrpt.pdf. SEE NPSVEG WEB PAGE INSTRUCTIONS FOR
FURTHER DETAILS.
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Zion

The webpages consist of the following files: aa_matrix.xls,
field_photos.exe, plots.xls, sp_cov.xls, parknamedata.mdb

{complete dataset), metaparknameortho.txt, metaparknameaa.txt,

metaparknamefiald txt, metaparknamespatial txt,
metaparknamebdy txt, parknameortho exe, parkname.exs,
parknameaaexe, parknameplot.exe, parknamebdy exe. The
following are EXAMPLES: ziondata.mdb, metagrteartho. pdf,
metazionaa.txt, metazionfield.txt, metazionspatial txt,

metazionbdy.txt, grteortho exe, zion.exe, zionaa.exe, zionplot.exe,

zionbdy.exe, OPTIONAL: class_matrix.xls, SEE NPSVEG WEB
FAGE INSTRUCTIONS FOR FURTHER DETAILS.
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